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DIRECTIVE NUMBER: 2003-1 (ADM 08-00)      EFFECTIVE DATE: March 20, 2003 

SUBJECT: OSHA Directives Tools-FAQ 

 ABSTRACT 

Purpose: This Notice introduces a writing and formatting tool for OSHA staff who write 
Directives. It will be posted and maintained on the OSHA Intranet, ‘Directives 
Tools’ web page, and is intended to aid Directives writers through the drafting 
and clearing processes. 

Scope: OSHA-wide 

References: OSHA Instruction ADM 8-0.2, OSHA Policy Issuances; OSHA Instruction 
ADM 8-0.3, OSHA Directives System; OSHA Instruction ADM 8-0.4, Non-
Policy Issuances; OSHA Instruction ADM 1-0.20, OSHA Internet and Intranet 
Policies and Guidelines. 

Cancellations: None 

Expiration Date: This Notice will expire on March 31, 2004 or upon posting the Directives Tools-
FAQ on the OSHA Intranet, ‘Directives Tools’ web page, whichever occurs first. 

State Plan Impact: This Notice does not describe a Federal Program Change 

Action Offices: National, Regional, and Area Offices. 

Originating Office: Office of Management Systems and Organization 

Contact: Office of Management Systems and Organization 
200 Constitution Avenue NW, N4624 
Washington, DC 20210 
Phone: 202-693-2002 

By and Under the Authority of 
David Zeigler 
Director, Administrative Programs 
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Executive Summary 

The OSHA Directives Tools-FAQ is a comprehensive list of questions directive writers frequently ask 
during the process of drafting and clearing a directive. The Notice introduces a tool that provides detailed 
answers and step by step guidance for creating OSHA Directives. This tool will be maintained on the 
OSHA Intranet, ‘Directives Tools’ web page. 

Significant Changes 

This Notice provides a new tool for Directives writers. It will be posted on the OSHA Intranet, 
‘Directives Tools’ web page, and the Office of Management Systems and Organization (OMSO) will 
keep the materials updated. Amending Notices will be issued only when substantive changes are 
introduced. 
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I Purpose 

This Notice introduces a writing and formatting tool for OSHA staff who write Directives. It will 
be posted and maintained on the OSHA Intranet, ‘Directives Tools’ web page, and is intended to 
aid Directives writers through the drafting and clearing processes. 

II Scope 

This Notice applies OSHA-wide. 

III Cancellations 

None. 

IV References 

OSHA Instruction ADM 8-0.2, OSHA Policy Issuances, December 11, 2000; OSHA Instruction 
ADM 8-0.3, OSHA Directives System, December 11, 2000; OSHA Instruction ADM 8-0.4, Non-
Policy Issuances, December 11, 2000; OSHA Instruction ADM 1-0.20, OSHA Internet and 
Intranet Policies and Guidelines. 

V Expiration Date 

This Notice will expire March 31, 2004 or upon posting the OSHA Directives Tools-FAQ on the 
OSHA Intranet, ‘Directives Tools’ web page, whichever occurs first. 

VI Actions Information 

A Responsible Office. Office of Managements Systems and Organization (OMSO). 

B Action Offices. National, Regional, and Area Offices. 

C Information Offices. State Designees, Consultation Project Managers. 

VII Action Required 

OSHA managers and supervisors should advise staff members who draft and clear Directives of 
this tool’s availability. 

VIII State Plan Impact 

This Notice does not describe a Federal Program Change requiring state adoption or response, but 
states are encouraged to consider its implications for their operations. 

IX Significant Changes 

This Notice provides a new tool for Directives writers. It will be posted on the OSHA Intranet, 
‘Directives Tools’ web page.  
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X Periodic Updates 

OMSO will keep the materials updated on the ‘Directives Tools’ web page. Amending Notices 
will be issued only when substantive changes are introduced. 

XI Final Authority 

This Notice introduces a tool that is an ancillary document to the package of administrative 
Directives concerning Agency policy and procedure pronouncements, non-policy issuances, 
letters of interpretation, and web publication (ADM 8-0.2, ADM 8-0.3, ADM 8-0.4, and ADM 1­
0.20, respectively). This tool does not update or supersede these Directives; they represent the 
final authority for questions and discrepancies between their contents and the current document.  
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OSHA Directives Tools-FAQ 

Writing and Clearing Directives: Frequently Asked Questions 

1. 	 Why do I need a Directive? 

2. 	 What is the difference between an OSHA Directive and an OSHA Non-Policy Issuance? 

3. 	 Are there different kinds of Directives? What is the difference between an OSHA Instruction, 
Notice, and Direction? What type of Directive do I need to publish? 

4. 	 Which software do I need to use for creating a Directive? Is the font face specified? 

5. 	 When can I publish a Directive as a manual? 

6. 	 What are the mandatory sections of the Directive? 

7. 	 What is a masthead? 

8. 	 What do I include in the Abstract? 

9. 	 Are there templates I can use? 

10. 	 How do I download a template for a Directive/clearance form? 

11. 	 What are the mandatory paragraphs in the body of the Directive? 

12. 	 If a standard paragraph is addressed in the Abstract, do I still need to include it in the body of the 
Directive? 

13. 	 Is there a rule for outline/numbering the paragraphs? 

14. 	 Is there a rule for numbering pages? 

15. 	 Where do I insert figures and graphics? 

16. 	 How do I create a table of contents? 

17. 	 How do I create an index? 

18. 	 How do I number the Directives? 

19. 	 What is the clearance/approval process? 

20. 	 How long is the process? Can I accelerate it? 

21. 	 Who are the mandatory clearance officials? 

22. 	 Which form do I need for clearance? How do I download it? 

23. 	 Do I have to do an OSHA 201/OSHA 202 whenever I ask anyone to comment on a draft? 

24. 	 What do I do when the clearance officials do not return the clearance sheet? 

25. 	 Who has the authority to review the drafts and sign approval? 

26. 	 How do I prepare the Directive for publishing? 

27. 	 Who has the authority to publish Directives on the OSHA web site? What is the process for 
publishing Directives? 

28. 	 For the list of hypertext links, why do I have to search for the addresses of the documents I’m 
referencing? 
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29. Where are the Directives filed/recorded? 

30. How do I revise or cancel a Directive? 

31. Where can I find written instructions on publishing Directives? 

32. Who can I contact for more help regarding drafting and publishing Directives? 

1. Why do I need a Directive? 

As a Federal agency, the Occupational Safety and Health Administration (OSHA) provides 
information about its requirements, policies and procedures to many groups including its staff, 
customers, stakeholders, partners, and the public.  Official statements of OSHA policy or 
procedure are generally established by and communicated through publication in the Federal 
Register, the Code of Federal Regulations (CFR), or the OSHA Directives system.  Legally 
binding requirements applicable to parties outside the agency, such as OSHA regulations and 
standards, and rules of procedure with which parties outside the agency are required to comply, 
are published in the Federal Register and codified in the CFR.   

Statements of new or revised OSHA policy or procedure that represent the official position of the 
agency, but are not legally binding on parties outside the agency, are generally established by and 
communicated through the OSHA Directives system. Exceptions to this policy require specific 
authorization by the Assistant Secretary. Information that does not establish or alter existing 
OSHA policy may be disseminated either through the Directives system or by using Directorate-
specific procedures governing non-policy issuances.  

2. What is the difference between an OSHA Directive and an OSHA Non-Policy Issuance? 

OSHA publishes Directives (Instructions or Directions) when the information you wish to 
communicate is to remain in effect for more than one year and: 
• Establishes new policy or procedure; 
• Amends established policy or procedure; 
• Interprets the Occupational Safety and Health Act of 1970; 
• Delegates, assigns, or changes authority or responsibility; 
• Establishes or changes organizational structure; 
• Revises or cancels another OSHA Directive; or 
• Establishes a recurring report or reporting format. 

OSHA publishes Notices to communicate short-term policy and procedure pronouncements that 
are not to remain in effect for more than one year.  

All other written and electronic materials issued by OSHA are Non-Policy Issuances (NPIs). NPIs 
include letters of interpretation, fact sheets, press kits, publications, health bulletins, e-mails, and 
routine correspondence. NPIs have to be consistent with all current OSHA policy. They are 
issued by OSHA Directorates and Offices using Directorate-level procedures for clearing and 
approval, and they concern matters within Directorates and Offices’ delegated authority. 
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3. 	 Are there different kinds of Directives? What is the difference between an OSHA Instruction, 
Notice, and Direction? What type of Directive do I need to publish? 

There are five types of OSHA Directives. Consult ADM 8-0.3, Chapter 1, paragraph XII, for 
more detail.  

Instructions. These are long-term policy and procedural pronouncements. Instructions also may 
be issued as Manuals. 

Notices. These are short-term policy and procedural pronouncements that are expected to remain 
in effect for one year or less. They may transmit informational materials, but may not amend an 
Instruction or Direction. 

Directions. These are policy and procedural pronouncements that are issued on a fast track to 
take effect quickly, in response to an urgent and immediate operational matter. They may remain 
in effect for up to 12 months. OSHA Directions have different formatting and clearance 
requirements than those for Instructions and Notices.  

Regional Instructions. These are long-term policy and procedural pronouncements that apply 
only within the originating Region or office. 

Regional Notices. These are short-term policy and procedural pronouncements that are expected 
to remain in effect for one year or less and that apply only within the originating Region or office. 

Supplementary Guidance. Supplementary, or Interpretive, guidance is a category of non-policy 
issuance.  It is usually prepared in response to a request for clarification or direction from an 
OSHA field office, a State Plan program, or a regulated entity.  Supplementary Guidance clarifies 
or more clearly articulates Agency policy as published in the CFR, Federal Register, and /or 
OSHA Directives System.  It must be issued in accordance with OSHA Instruction ADM 8-0.4. 

4. 	 Which software do I need to use for creating a Directive? Is the font face specified? 

OSHA is currently using Microsoft Word as the standard software for creating Directives. All the 
Tools on the Directives website will be updated to provide assistance in creating Microsoft Word 
documents and will replace earlier WordPerfect Tools. 
There is no specified font face to be used for writing directives, but Times New Roman 12 pt and 
Arial 11pt fonts are recommended. 

5. 	 When can I publish a Directive as a manual? 

Instructions may be issued as manuals if: 1) they are 20 or more printed pages; or 2) the program 
official justifies the issuance of the instruction as a manual and the OSHA Directive Officer 
approves. A manual should be consistent with the outline requirements for Directives and its 
contents need to be organized into chapters with titles that clearly convey the main idea. 

6. 	 What are the mandatory sections of the Directive? 

There are six main parts to a Directive; they appear in the following order: 
• 	 Masthead. 
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• 	 Abstract. The abstract is a summary of the Directive. It is preceded by a 
masthead. 

• 	 Table of Contents. 
• 	 Body of the Directive. It includes Mandatory Paragraphs and Optional 

Paragraphs.  The Mandatory Paragraphs provide information common to all 
Directives. You may include Optional Paragraphs to provide information related 
only to the specific Directive.  

• 	 Appendices. Appendices are optional; you may use them to provide information 
in great detail on a subject in the Directive. Appendices often list definitions and 
explain or illustrate technical subjects.  

• 	 Index. An Index is required for longer Directives. It is a cross-reference subject 
listing providing reference to the pages in the Directive where the reader can find 
specific subject references. 

7. 	 What is a masthead? 

The masthead, which precedes the abstract, is the header that is used on all Directives. Templates 
provide formats for appropriate mastheads for notices, instructions, or directions. Consult with 
your Directives Officer or Regional Directives Liaison to get a Directive number and subject, and 
with OMSO for an effective date. Regions add regional identifiers for instructions and notices. 

8. 	 What do I include in the abstract? 

The Abstract is a one- or two-page summary of the Directive’s contents that will be hyperlinked 
to the body of the Directive. The paragraphs in the Abstract do not need to be numbered and the 
paragraph headings do not need to be underlined (See ADM 8-0.3 for an example of an Abstract). 
The paragraphs you must include in the Abstract are: 

• 	 Purpose: Describe why the Directive is being issued and to what it pertains 
(policy, procedure, guidelines, etc.). This paragraph should be three or fewer 
sentences. 

• 	 Scope: Describe to whom the Directive pertains, and whether it applies only to 
headquarter offices or OSHA-wide. List the job titles, positions, or other defining 
characteristics of those impacted by the Directive. Omit this paragraph for 
Regional Directives. 

• 	 References: Provide title, number, and date for up to five related Directives, 
standards, regulations, publications, or other external documents such as Office 
of Management and Budget (OMB) circulars or American National Standards 
Institute (ANSI) standards. 

• 	 Cancellation: Use for Notices or Directions that cancel another Directive. 
Identify by title and number all Directives cancelled by your new Directive. 

• 	 Suspension: Use only for Directions that suspend another Directive. Identify by 
title and number all Directives suspended by your new Direction. 

• 	 Expiration Date: Use only for Notices and Directions. They expire after one 
year, unless you list another date. Include the expiration date: month, date, and 
year.  

• 	 State Plan Impact: Explain whether states must adopt a regulation, take action, 
respond with information, or simply consider how the Directive impacts their 
operations. Consult with the Directorate of Cooperative and State Programs to 
determine whether the draft Directive constitutes a federal program change and, 
if so, ensure that language about the change is correct. 
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• 	 Action offices: List the offices that must take action in response to the Directive. 
• 	 Originating Office: Name the office that originated the Directive. 
• 	 Contact: List an office to contact for more information about the Directive, 

ensuring that the organizational level of the contact is the Office level or below. 
Avoid using an employee’s name. 

• 	 Authority statement: Fill in the name of the authorizing official and list his or 
her title. 

• 	 Executive Summary: Write a short summary of the Directive’s contents and its 
most important features. 

• 	 Significant Changes: Use this paragraph for Directives that revise the previous 
version of the same Directive. List the major changes introduced by the new 
Directive and provide the title and effective date of the previous version. 

Information stated in the Abstract may have to be repeated in the body of the directive. 

9. 	 Are there any templates I can use? 

OMSO has created several templates for use in all Agency directives.  These templates have two 
parts, the masthead and the Abstract, and are designed as an easy method of gathering together 
the key information of and about a Directive. Once the information is inserted into the document, 
it can be freely edited, although you should never alter the template itself. Due to the limitations 
of the Microsoft Word application, each element of the template may be no more than 
approximately 50 words in length. If you cannot complete the item in 50 words, complete it after 
the template is converted into the Abstract. 
A.	 Types of Templates. Each type of Directive has an appropriate template. Templates may 

be obtained from the Directives Officer by disk or e-mail, or downloaded from the 
Directorate of Administrative Programs (DAP) web page. 
(http://omds.osha.gov/directorates/dap/directivetools.html) 

B.	 Template Items. Templates consist of individual items, which may vary from template to 
template. Several of the items may or may not be used, depending on the type of directive 
you are writing.  If you are not using any items on a template, simply select any 
uncompleted paragraph headings on the abstract and delete them after closing or 
completing the template.  Also check and make sure you completed all the desired 
wording. See ADM 8-0.3, Chapter 2, for more information. 

10. 	 How do I download a template for a Directive/clearance form? 

To download a template or form go to the DAP Directives Tools web page: 
 http://omds.osha.gov/directorates/dap/directivetools.html 
Select an appropriate template or form by clicking on the link (contact the Directives Officer if 
you need assistance in template/form selection). Choose ‘Save File’ and save the template/form in 
a folder of your choice. Templates may be used more than once for creating Directives. 

To access a template, open the folder you saved it in and double-click on the template. Microsoft 
Word will open the template as a new document.  When completed, save your document under a 
new name so that you don’t alter the original template and it is available for future use. Although 
it is advisable to complete the abstract before writing the body of the directive, the template 
(abstract) can be updated or completed later during the writing process. 
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11. 	 What are the mandatory paragraphs in the body of the Directive? 

Some of the mandatory paragraphs will be elaborations of items in the Abstract. Additional 
paragraphs are also required of all Instructions and Notices, per ADM 8-0.3.   

A. 	 Paragraphs that are mandatory for the body of all Directives: 
• 	 Purpose: As in the Abstract, this paragraph describes why the Directive is being 

issued and to what it pertains (policy, procedure, guidelines, etc.). It may be the 
same purpose statement as that used in the Abstract, or longer if appropriate. 

• 	 Scope: Use the Scope paragraph from the Abstract. 
• 	 Action Information: List the responsible office (the office with responsibility 

for the functions covered by the Directive); the action offices (the offices that 
must take action in response to the Directive); and information offices (offices 
that need to be notified about the new Directive but are not directly affected by 
it). See page 2-5 of ADM 8-0.3 for more details about action information. 

• 	 State Plan Impact: Explain whether states must adopt the regulation, take 
action, respond with information, or consider how the Directive impacts their 
operations. Consult with the Directorate of Cooperative and State Programs to 
determine whether this constitutes a federal program change and, if so, to ensure 
that language about the change is correct. Include the implementation deadline. 

B. 	 If your Directive cancels, suspends, refers to, or makes significant changes to another 
Directive; expires on a given date; or uses terms that require definition, the following 
paragraphs are also mandatory: 
• 	 Cancellation: Use the Cancellation paragraph from the Abstract. 
• 	 Suspension: Use the Suspension paragraph from the Abstract. Directions are the 

only type of Directives that can suspend other Directives. 
• 	 Reference: Use the Reference paragraph from the Abstract. You may add 

information in this paragraph about locating the referenced documents if useful. 
• 	 Significant Changes: Use this paragraph for Directives that revise the previous 

version of the same Directive. List the major changes made in the new Directive, 
and provide the title and effective date of the previous version. Provide enough 
detail about each change to explain its significance, and specify the paragraph 
numbers of the previous version that have been changed. 

• 	 Expiration Date: Include the expiration date (month, date, and year) for 
Directives that will expire. Notices and Directions expire after one year, unless 
you list another date. 

• 	 Definitions: Use this paragraph when the Directive uses technical terms or 
complex language. You may list definitions in an appendix or chapter instead, if 
the list is long. 

Once you have completed these paragraphs, you may supply any other relevant paragraphs such 
as background information, a list of authorities, or details about the Directive’s requirements. 
Select paragraph headings that will help the reader understand the main points. You can find 
additional information regarding mandatory and optional paragraphs in ADM 8-0.3, Chapter 2, 
paragraph VI. 

. 

* OSHA ARCHIVE DOCUMENT * 
This document is presented here as historical content, for research and review purposes only.



 

  
 

 

   
  

 
 

 
 

 
 

   
 

 
 

 
   

  
    

 
 

    
    
   

  
     

 

  
  

 

 
    

 
 

 

    
      

    
  

                 

* OSHA ARCHIVE DOCUMENT * 
NOTICE: This is an OSHA ARCHIVE Document, and may no longer represent OSHA policy.

12. 	 If a standard paragraph is addressed in the Abstract, do I still need to include it in the body of 
the Directive? 

Yes. The Abstract provides a quick one-page summary of the purpose and relevance of a 
Directive.  That is why it is important that entries be specific, informative, and concise. 
However, the Abstract is not part of the Directive proper.  Additionally, for many of the standard 
paragraphs, the Abstract cannot fully detail or explain the effects of the Directive. 

13. 	 Is there a rule for outlining/numbering the paragraphs? 

After completing the Abstract, but before writing the directive proper, you should set Microsoft 
Word in outline mode.  From the View pull-down menu select Outline and then choose Bullets 
& Numbering…/Outline numbered from the Format pull-down menu.  Select the Outline and 
click OK button. If you do not find the outline presented below, select a similar one, click 
Customize and specify numbering for each level of text. (Note: the number of levels will vary 
depending on the complexity of your directive.)  

For chapters, appendices and the index, type in the appropriate words in the Number Format 
window. Click More and in the extended menu in the Link level to style window enter Heading 
1 for level 1, Heading 2 for level 2, and Heading 3 for level 3. These three levels will be 
included in the table of contents. Specify numbering for level 4 without assigning heading style. 
Levels 5 & 6 (marked as heading styles 4 & 5) can be assigned to the appendices and index that 
you want to include in the ToC. Click OK. 

The selected outline should be numbered:

 Level 1:  Chapter 1 

 Level  2:   I. 

 Level  3:    A. 

 Level  4:     1. 

 Level 5:  Appendix A 

 Level 6:  Index (none) 


Directives usually will not require numbered paragraphs below the fourth level. Paragraphs below 
the fourth level must be equally indented, but may be designated, at the writer’s discretion, using 
numbers, bullets, or no designation at all. 

As you begin a new paragraph, select a heading style (Heading 1 for Chapter titles, Heading 2 for 
main paragraph headings etc.) under Format/Style and Microsoft Word will automatically insert 
appropriate number. Once heading style is assigned, you can use TAB and Backspace keys to 
switch between levels and heading styles. 

14. 	 Is there a rule for numbering pages? 

Each part of the Directive, e.g. Abstract, Table of Contents, body of text, Appendices, and Index 

should have its own page numbering. Number format for each section should be: 

Abstract     Abstract-1, Abstract-2 

Table of Contents i, ii, iii, iv,… 

Body of Text (chapter number-page number) 1-1, 1-2,…,2-1,… 

Appendices (appendix number-page number) A-1, A-2,…, B-1,… 

Index (numbering not required) 
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To restart page numbering for each section, insert a section break where you want to restart page 
numbering: from the Insert pull-down menu select Break…/Section break types: next page. 
Click in the section where you want to restart page numbering. On the Insert menu click Page 
Number/Format. In the Number format box click the format you want (select Include Chapter 
number for body of text and appendixes); in the Start at box enter 1. To insert the word 
‘Abstract’ with page numbers, on the View menu click Header and Footer. Move to the 
appropriate section of the document, make sure Same as Previous on toolbar is NOT selected. 
Type in an appropriate word. 

15. Where do I insert figures and graphics? 

You may include figures and graphics when they help illustrate the Directive’s contents. Place 
them in the Directive after each paragraph in which they are first mentioned. You may create 
graphics as external files with a hypertext link to minimize the time involved in downloading the 
Directive file. 

16. How do I create a table of contents? 

Directives in which the body of text is three or more pages long must have a Table of Contents 
(ToC). The ToC should include chapters (including appendices and the index) and the first two 
levels of paragraphs (and the third level if useful). All chapters and major paragraph headings on 
the published HTML copy will be hypertext linked to allow the electronic user to quickly move to 
and from key portions of the document.  Additional items in the ToC may be hypertext linked 
when those links will aid the reader to access key portions of the Directive. 

To create a ToC, make sure that you have applied heading styles to chapter titles, paragraph 
headings (also appendices and the index, if applicable) you want to include in the ToC. Click 
where you want to insert the ToC. On the Insert menu click Index and Tables, and then click the 
Table of Contents. In the Formats window choose From Template, and in Show Levels enter 3 
(or 5 if you have appendices and an index). Click OK. 

17. How do I create an index? 

Directives in which the body of text is three or more pages long must have an Index. The Index 
will be hypertext linked to the body of the Directive. To create an Index, first create a 
concordance file. This will allow the program to automatically mark words and phrases to be 
included in the Index. For detail on creating a concordance file, marking index entries and 
creating an index, refer to the Microsoft Word Help. 

18. How do I number the Directives? 

You must consult with the Directives Officer, or Regional equivalent, to determine the 
appropriate alphanumerical designation for a Directive.  Consult ADM 8-0.3, Chapter 4 for more 
details in this regard. 

19. What is the clearance/approval process? 

You should informally circulate drafts, reports, and other materials relating to a directive with 
affected OSHA organizations and the Directives Officer (OMSO) before initiating the formal 
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clearance process. A Directorate or Office head, or Regional Administrator typically initiates the 
formal clearance process. For Instructions and Notices, fill out appropriate clearance forms and 
email them with the Directive to the listed Clearance Officials. If necessary provide hard copies. 
Note the date you distributed the Directive and when the deadline for comments will be (at least 
15 working days after distribution). 

For Directions email the Directive to Clearance Officials and schedule a Clearance Conference to 
discuss questions and issues. Clearance Officials have 5 working days from the distribution of the 
Directive to provide comments. 

You must review and consider all comments and suggestions for changes, and revise the draft 
directive to address them, as appropriate. You must also maintain a file of all comments and the 
changes made in response to them. Significant issues or disagreements may need to be resolved 
through discussions or meetings.  You must re-clear a draft Directive whenever significant 
changes are made as a result of the initial clearance process. To facilitate re-clearance, it is 
important to indicate where significant changes have occurred. For details on clearance 
procedures and offices refer to ADM 8-0.3, Chapter 3; ADM 8-0.3 supersedes any previous 
Directives describing clearance process.  

When the clearance process is complete, you must send to the Directives Officer (OMSO) a 
Directives package that includes paper and diskette copies of the final Directive, the transmittal 
memo, all clearance forms, any comments or other materials received from Clearance Officials, 
and other relevant background material. In addition, you must prepare a transmittal memorandum 
from the Program Director to the appropriate approving official. 

The memorandum should: 
• 	 Request the signature of the Assistant Secretary or OSHA Administrative Officer, as 

appropriate; 
• 	 Explain the purpose and main features of the Directive; 
• 	 List the advantages and the risks for the Agency associated with issuing the new 

Directive; and 
• 	 Outline controversial comments made during the clearance and explain why comments 

were not adopted, if applicable. 

20. 	 How long is the process? Can I accelerate it? 

Normally, you should allow at least 15 working days for Clearance Officers to concur or 
comment. Consult with the OSHA Directives Officer in the event you desire shorter clearance 
period. Regional Offices may need additional time to respond if the clearance form and draft 
directives are not sent electronically to the Regional Administrators. 

21. 	 Who are the mandatory clearance officials? To which offices do I need to send directives for 
clearance? 

The list below contains the names of all mandatory clearance offices within OSHA and the SOL.  
You must determine which non-mandatory offices of OSHA have an interest in the subject and 
include them. Other clearance offices may include DOL, OMB, or other Federal agencies, and 
OSHA stakeholders who may have an interest in the subject of the Directive, and other interested 
parties you wish to consult. 
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• 	 The OSHA Labor-Management Relations Officer, or regional equivalent, and the OSHA 
Directives Officer, or regional equivalent must clear all Directives. 

• 	 All Directives originating in the National Office must be transmitted to and cleared by all 
Program Directors. 

• 	 The Director, Directorate of Cooperative and State Programs, will approve appropriate 
language for all Federal Program Change paragraphs. 

• 	 Directives affecting field operations must be transmitted to and cleared by Regional 
Administrators.  

• 	 Regional Directives (which affect only the offices within a specific Region) must be 
cleared by the Regional Administrator, affected Assistant Regional Administrators, 
affected Area Office Directors, the National Office Directorates and freestanding Offices 
responsible for the functions covered by the directive, the OSHA Directives Officer, and 
any other organization whose activities or functions are affected by the Directives. 

22. 	 Which form do I need for clearance? How do I download it? 

From the ‘Directives Tools’ web page download the OSHA 201 to send to the National Office 
and the OSHA 202 to send to Regional Offices. Complete items 1 through 7. For item 3 of OSHA 
201 or 202, list the Clearance Officials who will receive a copy of the Directive. These should be 
the same Officials you consulted during informal clearance. 

23. 	 Do I have to do an OSHA 201/OSHA 202 whenever I ask anyone to comment on a draft? 

No.  You should informally consult with interested parties (usually OSHA offices, state and 
consultation partners, and others selected by the originator) during the development of the draft 
and produce a draft that reflects some degree of consensus among you and the interested parties.  
You should then complete an OSHA 201 (or regional equivalent) and circulate the final draft for 
comments, consider the comments received and adopt, modify or reject them.  You should seek 
the concurrence of the commenter when you modify or reject the comments.  If the comments 
have a major impact on the Directive, the Directive should be re-cleared on another OSHA 201. 

24. 	 What do I do when the clearance officials do not return the clearance sheet? 

As the deadline for clearance approaches, you should contact officials who have not responded 
and ask whether they plan to concur. If they miss the deadline, ask your Program Director to 
negotiate an extension or discuss their concerns with them. If the Program Director and Clearance 
Officials are unable to resolve the issue, the Program Director will schedule a meeting with the 
Deputy Assistant Secretary. Absent resolution at this level, the Assistant Secretary will decide 
whether to issue the Directive as is, revise it, or defer action. 

25. 	 Who has the approval/signatory authority? 

• 	 Clearance Officers review drafts and respond to requests for comments from originators 
within the specified time period. 

• 	 Originators revise the Directive as necessary in accordance with comments received to 
obtain full clearance and submit the final Directive in electronic and paper format for 
signature to the Directives Officer or the regional Directives Liaison Officer. 
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• 	 Directives Liaison Officers ensure that all Directives originating under their jurisdiction 
are prepared properly.  They submit Directives to the Regional Administrator for 
signature, and forward an electronic copy to the Directives Officer. 

• 	 Regional Administrators sign regional Directives for their respective regions and file a 
paper copy for record keeping purposes. 

• 	 Directives Officer ensures that all Directives are properly prepared and cleared and 
submits national Directives for signature. 

• 	 Administrative Programs Director signs national Directives dealing with 
administrative subjects. 

• 	 Assistant Secretary or Deputy sign national Directives or delegate authority to 
subordinate managers. They approve the issuance of OSHA Directions. 

26. 	 How do I prepare the Directive for publishing? 

Following the clearance of a Directive, send to your Directives Liaison Officer a Directives 
package that includes paper and diskette copies of the final Directive, the transmittal memo, 
clearance forms, any comments or other materials received from Clearance Officials, and other 
relevant background material.  

The Directive Liaison Officer submits to the Directives Officer: 
• 	 Completed clearance forms 
• 	 Final copy of the Directive in an electronic format (diskette or e-mail) using the word 

processor’s hypertext capabilities to mark terms and generate the Table of Contents and 
Index, as well as a list of applicable terms and their location in the text of the Directive, 
including manuals, for hypertext links to other specified points in the Directive or to 
other on-line documents.  

• 	 The Directive in paper form with letterhead appropriate for signature by the Assistant 
Secretary or other approving official. Regional Directives should already have been 
signed by the Regional Administrator and filed appropriately within the region. 

27. 	 Who has the authority to publish Directives on the OSHA web site? What is the process for 
publishing directives? 

Directives that introduce new or changed policy or procedure have to be cleared during the 
clearance process as required by ADM 8-0.2, ADM 8-0.3, ADM 8-0.4, and PUB 8.4A. Directors 
of Directorates and Free-Standing Offices, and Regional Administrators are responsible for 
clearance of all materials which will appear on the OSHA website. Once the Directive is cleared 
and signed by the approving official, the Directive Liaison Officer submits the electronic copy 
(see Q24 above) to the Directives Officer who contacts the OSHA Webmaster to request web 
publication.  

28. 	 For the list of hypertext links, why do I have to search for the addresses of the documents I’m 
referencing? 

Although in most cases the destination specified is unique and easy to find (often another 
directive), in those cases where it is not, it would be very difficult for the person actually 
converting the Directive to electronic format to track backwards and find you to determine 
exactly what site or page you meant.  The overall burden of locating these addresses (Universal 
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Resource Locators or URLs) should be relatively small.  The URL for any site is displayed in the 
Location box of the Web browser. 

29. 	 Where are the directives filed/recorded? 

• 	 The OSHA Directives Officer, OMSO, maintains a historical Directive file in paper 
media on all current and canceled national Directives. The paper Directive file includes 
clearance forms and other related documentation. 

• 	 Regional Directives Liaison Officers maintain a paper Directive file on all current and 
canceled Directives issued by their region, including clearance forms and all related 
documents, both formal and informal, from the drafting process. 

• 	 Originating offices maintain the paper Directive development file including a final 
version and all related documents, both formal and informal, from the drafting process. 
They also maintain a final word processing version of the Directive for use in future 
revisions. 

• 	 The OSHA Webmaster maintains in electronic form all current and canceled national 
and regional Directives. The Webmaster also maintains on the OSHA website the most 
recent version of each Directive that has been published on the Internet. 

30. 	 How do I revise or cancel a Directive? 

There are three ways to revise or cancel a Directive: 
• 	 Cancel the former Directive through the cancellation paragraph of a new or revised 

Instruction or Notice; 
• 	 Issue a Direction that cancels or suspends the former Directive; or 
• 	 Use a Notice created for the sole purpose of canceling a Directive that will not be 

superseded by another Directive. 

31. 	 Where can I find written instructions on publishing directives? 

OSHA’s “New” Directives System was instituted in December 2000 with the issuance of four 
Directives that together form this “new system”.  Instructions ADM 8-0.2, ADM 8-0.3 and ADM 
8-0.4 provide a comprehensive framework of guidance and direction to ensure the effective 
management and communication of OSHA policies and procedures, interpretive guidance, and 
other materials. ADM 1-0.20 provides specific guidance related to publishing such materials on 
the OSHA Internet and Intranet. 
Together these Instructions: 
• 	 stress the policy nature and implications of Directives and the Directives clearance 

process and encourage internal Agency dialogue on such matters; 
• 	 clarify Directives review and clearance responsibilities; 
• 	 establish all OSHA Program Directors (Directors of Directorates and free-standing 

Offices) as mandatory clearance officials; 
• 	 require that originators provide to clearance officials all policy and other background 

information appropriate to their review; 
• 	 require that originators obtain and appropriately consider critical policy and other issues 

in the development and review of proposed directives; 
• 	 require that clearance officials carefully consider the broad policy implications of 

proposed Directives; 
• 	 establish a 15-day time frame for normal Directives review and clearance; 
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• 	 stipulate a process for the resolution of disagreements or slowdowns in Directives 
clearance; 

• 	 provide for Assistant Secretary approval of case-by-case exceptions; 
• 	 replace the Interim Directive with a new vehicle for expedited (5-day) clearance of policy 

material, the OSHA Direction (DIR); and 
• 	 fix responsibility for the management, clearance, and release of non-policy issuances 

(NPIs) by OSHA Directorates, Regions, and Offices. 

ADM 8-0.2, OSHA Policy Issuances clarifies and codifies OSHA’s policy covering the issuance 
of new or revised policies or procedures, emphasizing the need for policy to be communicated 
through the Code of Federal Regulations (CFR), the Federal Register (FR), or the Directives 
system.   It provides that OSHA Directives, together with Agency publication of materials in the 
CFR and FR, serve as the public and legally responsive statements of Agency policy and 
procedure, and help ensure internal Agency consistency. 

ADM 8-0.3, OSHA Directives System provides process and procedural guidance for drafting, 
clearing and issuing OSHA Directives. It specifies the types, mandatory elements, timeframes, 
and other details for OSHA Directives.   

ADM 8-0.4, OSHA Non-Policy Issuances establishes the Agency’s system for managing non-
policy issuances (NPIs), including such supplementary guidance materials as its letters of 
interpretation, and other non-policy statements issued by the Agency.   

ADM 1-0.20, Internet Policies and Procedures establishes that the Agency will post to its and the 
Department of Labor’s several websites only materials that have been cleared for issuance in 
accordance with the directives system instructions.   

Each of these Instructions is available on the OSHA web page: 
http://www.osha.gov/pls/oshaweb/owasrch.search_form?p_doc_type=DIRECTIVES&p_toc_leve 
l=0&p_keyvalue= 

32. 	 Who can I contact for more help regarding drafting and publishing directives? 

You may direct questions regarding the Directives process to the Directives Officer at the Office 
of Management Systems and Organization (x32002).  
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